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About this Manual

About this Manual
Whilst every effort has been taken to produce an error free manual from time to time Microsoft updates their applications 
and features may change.
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Icons used in this manual

Icons used in this manual

  Warning Take note when you see me

  User Tip

  Keyboard Short Cut Available
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Introduction

Introduction
Microsoft Office Visio 2010 is drawing and diagramming software that helps make it easy for IT and business professionals 
to visualize, explore, and communicate complex information. Go from complicated text and tables that are hard to 
understand to Visio diagrams that communicate information at a glance. Instead of static pictures, create data-connected 
Visio diagrams that display data, are easy to refresh, and can dramatically increase your productivity. Use the wide variety 
of diagrams in Office Visio 2010 to understand, act on, and share information about organizational systems, resources, 
and processes throughout your enterprise.
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First Look at Visio 2010

First Look at Visio 2010
Microsoft Visio 2010 is a tool to create a great variety of drawings ranging from network diagrams to calendars and from 
office layouts to flowcharts. Visio 2010 creates professional visual documents to help analyse and communicate complex 
information, systems, and processes. 

With Visio 2010 you can improve your understanding of systems and processes, gaining insight into complex information.

http://bookboon.com/
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Getting Started

Getting Started
When you open Visio 2010 the first window that is displayed, by default, is the Choose a Template window, showing 
you recently used Templates.

The screen is laid out in to three parts, on the left side a simple navigation system that replaces the file menu, the template 
section that has browser type controls at the top of the screen, and to the right hand side of the screen a template preview 
window.

http://bookboon.com/
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Selecting your template

Selecting your template
•	 Recently Used Templates area shows templates that you have recently used.
•	 Template Categories area displays the template categories, clicking on a category displays all the templates 

associated with that category. Double Click on the template to open it or select the template and click the 
create Button

•	 If you have selected the wrong group click on the Home icon to take you back to the Template category 
section and the reselect the correct template.

�
�
� � � �������	�
�����	�
��

In Paris or Online
International programs taught by professors and professionals from all over the world 

BBA in Global Business
MBA in International Management / International Marketing
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Innovative – Practical – Flexible – Affordable

Visit: www.HorizonsUniversity.org
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Call: 01.42.77.20.66 www.HorizonsUniversity.org
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Open a sample File

Open a sample File
Before we explore creating Visio diagrams, we first explore the Visio sample files. From the home page Navigate to other 
ways of getting started, and click on Sample Diagrams.

•	 Your screen will now look like this

http://bookboon.com/
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Open a sample File

•	 Select Process Improvement then choose either metric or us units then Click  the open Button

•	 You should now see the diagram as illustrated bellow
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Zooming

Zooming
You probably have difficulty reading the text on the diagram so we can use the zoom control located bottom left of the screen

Sliding to the right or using the (+) key to zoom in or slide to the left or click on the  ( –) key to zoom out.   Normal 
View.

Fit to Page ,  Pan and Zoom Window,  Switch Windows,  Full Screen

You can also zoom from the view tab and the zoom Group Or by using the CTRL + Mouse Wheel

http://bookboon.com/
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Pan and Zoom

Pan and Zoom

Click The  Pan and Zoom Window Icon this will display the pan and zoom window as displayed below.

As you move the slider control towards the top of the screen and the red square gets smaller zooming in on the highlighted 
are, Drag the red square around the screen to zoom in on the underlying area,

You can also Click and drag the mouse within the pan and zoom window to draw the red box. Your drawing page will 
be zoomed to the selected area.

http://bookboon.com/
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Pan and Zoom

 Clicking on the pushpin to turn on auto hide

Click the cross to close the pan and Zoom Window.

http://bookboon.com/
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Closing a Diagram

Closing a Diagram
From either the file men click Close or click the  Button

This will close your drawing. Click don’t save to continue.

Your Screen will now look as the illustration below

http://bookboon.com/
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Closing a Diagram

•	 To redisplay the home screen click the file tab
•	 Then click the new Button.

•	 From the categories areas select flow Chart.

•	 Select Basic Flow Chart.
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Closing a Diagram
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Visio Screen Layout

Visio Screen Layout

The File Menu whilst part of the ribbon bar this is the only tab that still resembles a menu, the remainder follows the 
ribbon layout introduced in office 2007.

http://bookboon.com/
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Visio Ribbons

Visio Ribbons
Ribbons are tabs that show different commands with respect to what you wish to do. Those are divided to sections in 
order to group the similar tools together. The HOME ribbon shows basic commands

 

Apply now at 
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Copenhagen Master of Excel lence are 
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The Home Tab

The Home Tab

Most Common features are found on the home Tab
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The Insert Tab

The Insert Tab

The way to think of this tab is if you are going to insert an object look here first

Contextual Tabs

These tabs only become available when you perform certain tasks

Design Tab

Page set up Themes and backgrounds and connector layout

Data Tab

This tab allows quick connection to external data sources some new graphics to show shape data also found here

http://bookboon.com/
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The Insert Tab

Process Tab

Some nice features here check diagram and access to SharePoint

Review Tab

The Reviewing Pane displays all of the changes that currently appear in your drawing, and allows other users to comment 
on your drawing. Also all your spelling and thesaurus options are found under this tab you also generate shape reports 
from here as well.

View Tab

Grid options, zoom options and windows options are found here you may wish to turn off auto connect from here.

Developer Tab

The developer tab by default is hidden but it is well worth turning on to access shape operations and the shape sheet window

http://bookboon.com/
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The Insert Tab

Turn on Developer Tab

•	 Select the file tab.
•	 Go to options.
•	 Select Advanced.
•	 Scroll down to General. Check click in developer mode.

http://bookboon.com/
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The Shape Pane

The Shape Pane

The shapes pane contains different shapes under different tabs; these tabs are known as stencils. Different stencil sets 
open dependant on the template chosen. You can search for shapes and you create your own stencil set we will look at 
these later in the book.

http://bookboon.com/
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The Drawing Page

The Drawing Page
The drawing page is the main page where you design and create your visual content. You can drag the shapes and stencils 
on to the main page and a visual diagram or document.

the best master  
in the netherlands
Kickstart your career. Start your MSc in Management in September, graduate within 16 months 
and join 15,000 alumni from more than 80 countries.

Are you ready to take the challenge? Register for our MSc in Management Challenge and compete 
to win 1 of 3 partial-tuition revolving scholarships worth € 10,000!

www.nyenrode.nl/msc

Master of Science in Management

* Keuzegids Higher Education Masters 2012,  
in the category of business administration

*
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The Task Pane

The Task Pane
This no longer exists in this application; all the options are found on the ribbon.
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Help for Visio

Help for Visio

As with all Microsoft Applications Pressing F1 will access help. You can also access help from the internet directly from 
Microsoft’s website when you access help from the File menu.

You can select from the displayed topics or type in a topic to search for then click Search.

http://bookboon.com/
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Extended Topics List

Extended Topics List
Click on the icon shown below in the help box to expand all Visio Topics Extended Topics List

Select Create diagrams for a comprehensive list of how to create diagrams

http://bookboon.com/
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Extended Topics List

Destination MMU
MMU is proud to be one of the most popular universities in the UK. 
Some 34,000 students from all parts of the globe select from its 
curricula of over 1,000 courses and qualifications. 

We are based in the dynamic yet conveniently compact city of Manchester, 
located at the heart of a sophisticated transport network including a major 
international airport on the outskirts. Parts of the campus are acclaimed for 
their architectural style and date back over 150 years, in direct contrast to 
our teaching style which is thoroughly  modern, innovative and 
forward-thinking. 

MMU offers undergraduate and postgraduate courses in 
the following subject areas: 

• Art, Design & Performance 
• Computing, Engineering & Technology 
• Business & Management 
• Science, Environmental Studies & Geography 
• Law, Education & Psychology 
• Food, Hospitality, Tourism & Leisure Studies 
• Humanities & Social Science 

For more details or an application form
please contact MMU International.
email: international@mmu.ac.uk
telephone: +44 (0)161 247 1022
www.mmu.ac.uk/international
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Extended Topics List

Printing Help Topics

Click the  icon to print your help topic.

Visio Online Help

www.microsoft.com/office/visio

***** Close Visio without saving any changes. *****
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Working with Drawings
Using Templates

We will open a basic flowchart and then learn how to add shapes.

Launch Visio 2010

From the template categories select Flowchart
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Working with Drawings

•	 Select Basic Flow Chart

 

•	 Select the correct unit of measurement and click create.

The screen opens showing the appropriate stencils for the chosen template, in this case all the stencils related to flow charts.
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Using Shapes

Using Shapes
About Stencils

Stencils are a collection of shapes either predetermined by the template that you choose, or from a custom stencil you 
create, many stencils are available from the web some are free but others you will pay for a good place to start looking 
on the web is the Visio Café 

Develop the tools we need for Life Science
Masters Degree in Bioinformatics

Bioinformatics is the  
exciting field where biology, 
computer science, and  
mathematics meet.  

We solve problems from 
biology and medicine using 
methods and tools from  
computer science and  
mathematics.

Read more about this and our other international masters degree programmes at www.uu.se/master
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Visio File Extensions

Visio File Extensions
Microsoft Visio Stencil (.VSS)  .VSS is the file extension given to Visio stencils, Visio stencils are separate objects to the 
drawing which have file extensions of (.VSD) and you also have (.VST) these are Visio Templates.
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Working with Shapes from a Basic Flow chart Template

Working with Shapes from a Basic 
Flow chart Template
Adding a Shape to the drawing Area

To add a shape to the drawing, simply drag a shape from the shapes pane to the drawing window. Click on the left mouse 
button and whilst keeping the button depressed, drag the shape onto the drawing window

The Drawing pane above should now look like this

Click on an empty area on the drawing to deselect your drawing will now look like this.
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Working with Shapes from a Basic Flow chart Template

Adding More Shapes

Move the mouse pointer over the shape but do not click, as you hover you will see a four way directional arrows, when 
you hover over that you are presented with a ghost shape box you can then select a shape from the ghost Box.

  NOTE: if you click a shape from the shape pane then click on the arrow that shape will be added. Visio 
remembers the last shape used.

SSTSTSTSTTUUDUDDYY Y IINN SSWWWEDEN 
––  HHOHOOMMEMEE O OOFF THE NOBEL PRIZE
CLOSE COLLABORATION WITH FUTURE 
EMPLOYERS SUCH AS ABB AND ERICSSON

WWEWWEWEELLCLCCOOMOME E TTOO 
OOOUOUURR WWOORRLLDD
OOFOFF T TEAACCHCHINNG!G!
INNOVATION, FLAT HIERARCHIES 
AND OPEN-MINDED PROFESSORS

SASHA SHAHBAZI 
LEFT IRAN FOR A 

MASTERS IN PRODUCT 
AND PROCESS 

DEVELOPMENT AND 
LOTS OF INNEBANDY
HE’LL TELL YOU ALL ABOUT IT AND 

ANSWER YOUR QUESTIONS AT 
MDUSTUDENT.COM

www.mdh.se
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Auto Connect

Auto Connect
Using the method described allows quick building of diagrams in Visio 2010 

  NOTE: using this method shapes self join. Auto Connect can be unchecked from the view tab, visual aid 
group.

The drawing below shows how dragging the shapes out no joins are made between shapes. 
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Auto Connect

Layout your screen as follows

 

  NOTE: if when adding shapes to your drawing you make mistakes you can either press CTRL+Z (undo) 

or use the undo icon from the quick access toolbar  

http://bookboon.com/


Download free ebooks at bookboon.com

Visio 2010

48 

Adding Text to the shape

Adding Text to the shape
We have now created a basic flow chart, but without any text on the shapes the drawings are meaningless. To add text to 
the shape either Click on the shape and start typing, two things happen you are taken into edit mode and Visio zooms 
in to the shape to assist you typing making the text easier to type in Double Clicking on a shape Does the same. Add the 
text to your diagram as shown below.
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Manually connect shapes

Manually connect shapes
Up to now we have let Visio Connect the shapes we have added; now we will add some shapes manually.

Look at the first diamond shape the diamond is the industry standard for a decision at present the work flow follows 
through to grammar check, we will add a path where as the proof is rejected taking us back to the previous process,

Adding the Connector

•	 Select the Diamond Shape.

•	 Select the connector tool button from the home tab
•	 Move the mouse to the position shown below note the cursor has changed to reveal the connector tool. As 

you position to a point you can connect to the shape a small red square will appear.
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Manually connect shapes

•	 Depress the left mouse key and drag the mouse pointer to the centre left edge connection point of the shape 
above

•	 Release the mouse Button and you will see a connector from the diamond to the rectangle above ad shown 
below

Repeat the process to display drawing as shown right.
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Manually connect shapes

Once you have made the connection click back on the pointer tool. 

http://bookboon.com/
http://bookboon.com/count/advert/44a2fd82-96d7-e011-adca-22a08ed629e5


Download free ebooks at bookboon.com

Visio 2010

52 

Connector types

Connector types
Static Connections (Also called point connection)

To keep the connector glued to a specific point on a shape, drag from a connection point on the first shape to a connection 
point on the second shape. The connector endpoints turn red when the shapes are connected. This is called a point 
connection.

Dynamic Connections (Also called shape to shape)

To allow the connector to move around the shape when the shape is moved, position the Connector tool over the centre of 
the first shape until a red box appears around the shape. Hold down the mouse button and drag to the centre of the second 
shape. When a red box appears around the second shape, release the mouse button. This is called a dynamic connection.

Notice the connection points the start point is a outline shape the end shape has a solid fill, also note that the shape to 
shape connector has an outline around the shape.
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Add text to connectors

Add text to connectors
•	 Double click on the connector line to type in text

•	 Enter your required text then click away from the Line

•	 Layout you’re Document as below.
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Add text to connectors
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Delete a connector

Delete a connector
To delete a connector, first select the connector to delete and then press the Delete (Del) Key on your keyboard. Delete 
connectors on the page then use CTRL+Z to restore your document to its former state.

Do you want your Dream Job?

More customers get their dream job by using RedStarResume than 
any other resume service.

RedStarResume can help you with your job application and CV. 

Go to: Redstarresume.com

Use code “BOOKBOON” and save up to $15

(enter the discount code in the “Discount Code Box”)
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Saving your work

Saving your work
•	 From the file menu select save the following Dialogue Box 

•	 Enter your required file name

Save your drawing type if you are required to save for Visio 2002 you must select that option from the drop down list.

http://bookboon.com/


Download free ebooks at bookboon.com

P
le

as
e 

cl
ic

k 
th

e 
ad

ve
rt

Visio 2010

57 

Close your drawing

Close your drawing
Select file Menu and close or use ALT+F4

By 2020, wind could provide one-tenth of our planet’s 
electricity needs. Already today, SKF’s innovative know-
how is crucial to running a large proportion of the 
world’s wind turbines. 

Up to 25 % of the generating costs relate to mainte-
nance. These can be reduced dramatically thanks to our 
systems for on-line condition monitoring and automatic 
lubrication. We help make it more economical to create 
cleaner, cheaper energy out of thin air. 

By sharing our experience, expertise, and creativity, 
industries can boost performance beyond expectations. 

Therefore we need the best employees who can 
meet this challenge!

The Power of Knowledge Engineering

Brain power

Plug into The Power of Knowledge Engineering. 

Visit us at www.skf.com/knowledge
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Open a previous drawing

Open a previous drawing
•	 From the file menu select open this opens the file explorer dialogue box navigate to the correct folder and 

select the file you wish to open.

http://bookboon.com/


Download free ebooks at bookboon.com

Visio 2010

59 

Manipulating shapes

Manipulating shapes
Moving shapes

To move a shape click on the shape then drag it to the new position. Experiment moving some shapes on the screen.

Resizing a Shape with the Mouse

•	 Select the shape to be resized.
•	 Move the mouse pointer to the required Resize handle:
•	 Drag the handle until the shape is at the required size.

 

•	 Release the mouse button.

Click and drag on any corner when resizing to maintain the shape’s height-to-width proportions.

Resizing a Shape with the Size & Position Window

•	 Select the shape to be resized.
•	 From the View Ribbon, Show section, Task Panes select Size & Position.
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Manipulating shapes

•	 the following window will appear in the bottom left of the screen:

•	 Increase/decrease the Width and Height values to change the size of the shape.
•	 The X and Y values refer to the position of the shape on the drawing page.

Rotate shapes

•	 Select the shape.
•	 Use the Rotate handle to drag the shape round as far as necessary:

Changing the Centre of Rotation

The centre of rotation is normally positioned in the centre of the shape and defines the point at which the shape will 
rotate. The centre of rotation can be moved at any time.

•	 Select the shape and move the mouse pointer over the Rotate handle (see above).
•	 The Centre of Rotation will appear in the centre of the shape:
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Manipulating shapes

Move the mouse over the centre of rotation and click & drag it to another position.

Deleting shapes

•	 Select the shape to be deleted.
•	 Press the Delete key.

NNE and Pharmaplan have joined forces to create 
NNE Pharmaplan, the world’s leading engineering 
and consultancy company focused entirely on the 
pharma and biotech industries.

Inés Aréizaga Esteva (Spain), 25 years old
Education: Chemical Engineer

NNE Pharmaplan is the world’s leading engineering and consultancy company 
focused entirely on the pharma and biotech industries. We employ more than 
1500 people worldwide and offer global reach and local knowledge along with 
our all-encompassing list of services.                                    nnepharmaplan.com

– You have to be proactive and open-minded as a 
newcomer and make it clear to your colleagues what 
you are able to cope. The pharmaceutical fi eld is new 
to me. But busy as they are, most of my colleagues 
fi nd the time to teach me, and they also trust me. 
Even though it was a bit hard at fi rst, I can feel over 
time that I am beginning to be taken seriously and 
that my contribution is appreciated.

Trust and responsibility  
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Manipulating shapes

Duplicating a Shape

•	 Select the shape to be duplicated.
•	 Select Duplicate from the Paste Button on the Home Ribbon, and a copy of the shape will appear directly 

beside the original:

•	 CTRL+D will do the same.
OR

•	 Hold down the CTRL key and move the shape to its new position, a copy is created.
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Adding Borders, Titles and Backgrounds

Adding Borders, Titles and 
Backgrounds
Access backgrounds from the design tab, these add styles to your page 

•	 From the drop down list click on the background you want to apply.
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Adding Borders, Titles and Backgrounds

Notice on the above drawing two things have happened a background has been applied and in doing so it has created a 
new page called vbackground-1

If you don’t like the background simply repeat the above process either selecting a new background or select none to 
remove this also removes the background page as long as it is not used on any other pages.
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Borders and Title Stencil

Borders and Title Stencil
•	 Select the design tab Click on Borders and Titles Click on the option you require. As you see below you 

can see that a date and title has been added to the drawing.
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Edit the Title

Edit the Title
•	 Go to the background page, select the title then click on the object you wish to change the text for and 

overtype with your text.
•	 Remember to switch back to your drawing page.
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Managing Stencils

Managing Stencils
My Stencil (formerly Favourites)

You now store custom shapes and shapes from other stencils in custom stencils. These custom stencils are stored in My 
Shapes folder, in My Documents.

Create a new stencil

Select More shapes from the shapes pane from the sub menu select new stencil, select your unit of measurement 

You are now presented with a new stencil in the stencil pane window

The red asterisk indicates the stencil is in edit mode
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Managing Stencils

Naming a stencil and saving a stencil

•	 Right click on the title line on the stencil and select save.

•	 The name you give here is the name for the stencil
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Managing Stencils

Close Stencil

•	 To close the stencils right click on the stencil name and select close from the menu.
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Managing Stencils

Re-open stencil

Select more shapes, my shapes then select your stencil.

Float Stencil

•	 Drag from the stencil name into the main drawing window

Re Dock Stencil

•	 To dock the stencils again drag the stencil back to the stencil pane.
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Managing Stencils

Add shapes to a stencil

•	 Open your stencil then drag it to the drawing screen.
•	 Locate the shape you want and drag it to your stencil
•	 You will see the following message click yes to continue

•	 Drag from any stencil the shapes you want to use onto your stencil.
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Accessing more stencil sets

Accessing more stencil sets
Whilst stencils open according to what template you choose you can open any stencil set installed into Visio or any .VSS 
file you are sent, 

Add clipart and pictures to stencil

To add clipart or pictures to your stencil first add them to your drawing, once they have been added drag them to your 
stencil. Remember to click the save button to update your stencil.

Name Your Objects in the stencil

•	 Right click on the object, select edit master, master properties
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Accessing more stencil sets

This dialogue box below opens

Enter a short name to display on the stencil menu.

Text typed here is the extended version and will appear when you hover over the shape or show text only description

Text typed here becomes keywords for Visio shape search.

This shows you an edited shape with name and Prompt
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Accessing more stencil sets

Change or edit icon

Right click the icon of the shape you want to change to open the Icon Editor.

Make changes and close icon editor to update

Add text to stencil

Type is some text onto the drawing or copy some text from word and paste it onto the drawing size the text box and 
format the text. Now drag the text Box onto the stencil.

Add custom shapes to stencil

  NOTE: any changes you make to a shape colour size border thickness is classified as a custom shape, 
simply drag your shape into you custom stencil to save it
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Accessing more stencil sets

Menu Layouts

•	 Right click on shapes and select the view that you want.

Dedicated Analytical Solutions
FOSS
Slangerupgade 69
3400 Hillerød
Tel. +45 70103370

www.foss.dk

The Family owned FOSS group is 

the world leader as supplier of 

dedicated, high-tech analytical 

solutions which measure and 

control the quality and produc-

tion of agricultural, food, phar-

maceutical and chemical produ-

cts. Main activities are initiated 

from Denmark, Sweden and USA 

with headquarters domiciled in 

Hillerød, DK. The products are 

marketed globally by 23 sales 

companies and an extensive net 

of distributors. In line with 

the corevalue to be ‘First’, the 

company intends to expand 

its market position.

Employees at FOSS Analytical A/S are living proof of the company value - First - using 
new inventions to make dedicated solutions for our customers. With sharp minds and 
cross functional teamwork, we constantly strive to develop new unique products - 
Would you like to join our team?

FOSS works diligently with innovation and development as basis for its growth. It is 
reflected in the fact that more than 200 of the 1200 employees in FOSS work with Re-
search & Development in Scandinavia and USA. Engineers at FOSS work in production, 
development and marketing, within a wide range of different fields, i.e. Chemistry, 
Electronics, Mechanics, Software, Optics, Microbiology, Chemometrics.

Sharp Minds - Bright Ideas!

We offer
A challenging job in an international and innovative company that is leading in its field. You will get the 
opportunity to work with the most advanced technology together with highly skilled colleagues. 

Read more about FOSS at www.foss.dk - or go directly to our student site www.foss.dk/sharpminds where 
you can learn more about your possibilities of working together with us on projects, your thesis etc.
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Searching for a Shape on a Stencil

Searching for a Shape on a Stencil
If you are unsure which stencil contains the shape you require, then a search can be performed from the More Shapes Menu.

•	 Select the Search for Shapes option from the More shapes Menu.

•	 Enter the word or phrase in the Search for Shapes: box and click the arrow to start the search.
•	 The results will appear in a temporary stencil:
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Searching for a Shape on a Stencil

•	 When a new search is performed, these results will be replaced by those of the new search.
•	 The results stencil can be closed at any time in the normal way.
•	 You can make some adjustment to the Search setting by going to the File menu, Options and scrolling to 

the Shape Search part in the Visio Options window.

Rename a stencil

•	 Open more shapes, my shapes organise my shapes.
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Searching for a Shape on a Stencil

This opens the document explorer window where the stencils are stored, select the appropriate stencil then right click to 
open the sub menu, from the sub menu click on rename and enter your new name.

 NOTE: you can not rename stencils if you have them open is Visio
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Working with Shapes

Working with Shapes
Shape is the general term for the objects you will find on a stencil and objects created using the drawing tools. These 
include geometric shapes such as rectangles, triangles and ellipses as well as more specialised shapes.
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 The Wake
the only emission we want to leave behind
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Creating a shape

Creating a shape
•	 Locate the required shape on the stencil.
•	 Click and hold down the mouse button on the shape.
•	 Drag it over to your page.
•	 Let the mouse button go when you have positioned the shape in the preferred location.
•	 The shape will appear with 8 square (Resize) handles around the outside and 1 round (Rotate) handle at the 

top.
•	 These Selection Handles tell us the shape is active and able to be edited.
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Selecting shapes

Selecting shapes
Shapes must be selected before any action such as copying, deleting and formatting can go ahead.

To Select a Single Shape

•	 Click on the shape with the left mouse button.
•	 The selection handles described above will appear.

To Deselect A Shape

•	 Click on any blank area of the page.

To Select Multiple Shapes Using the Keyboard

•	 Select the first shape.

•	 Hold down the SHFT key on the keyboard and select the second shape.
•	 The selection handles now form a rectangle that surrounds both of the shapes:

•	 Further shapes can also be selected using the same method.
•	 While still holding down the SHFT a selected shape can be deselected by clicking it for a second time.
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Selecting shapes

To Select Shapes Using the Area Select Tool

This method involves dragging a selection box around the shape or shapes to be selected.

•	 Starting above and to the left of your shapes, click and drag your mouse towards the bottom right of your 
shapes:

•	 Make sure all parts of the required shapes are within the selection box.
•	 Release the mouse button when you are happy with your box; if not, click away so nothing is selected and 

try to drag the box again.

To Select Shapes Using the Lasso Select Tool

This method involves drawing a selection ‘lasso’ of any shape around the shape or shapes to be selected.

 

•	 From the Editing section of the Ribbon choose Select and click on the Lasso Select button.
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Selecting shapes

 

•	 Click and drag with the mouse to start drawing the lasso.
•	 Ensure the shapes to be selected are fully within the lasso.
•	 If possible overlap the start and end points of the lasso (although this is not always essential).

Both the Area Select and the Lasso Select methods can be used in conjunction with the Multiple Select method in order to 
easily select multiple shapes which are positioned in different parts of the drawing page.

To Select All Shapes on a Page

•	 In the Select button, choose Select All.

OR

•	 Press CTRL+A.
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Moving Shapes

Moving Shapes
•	 Point your mouse at the shape to be moved.

 

•	 Click and hold down the mouse button.
•	 Drag the shape to the new location.
•	 Release the mouse button.

   Technical training on 
WHAT you need, WHEN you need it

 At IDC Technologies we can tailor our technical and engineering 
training workshops to suit your needs. We have extensive 

experience in training technical and engineering staff and 
have trained people in organisations such as General 
Motors, Shell, Siemens, BHP and Honeywell to name a few.
Our onsite training is cost effective, convenient and completely 
customisable to the technical and engineering areas you want 
covered. Our workshops are all comprehensive hands-on learning 
experiences with ample time given to practical sessions and 
demonstrations. We communicate well to ensure that workshop content 
and timing match the knowledge, skills, and abilities of the participants.

We run onsite training all year round and hold the workshops on 
your premises or a venue of your choice for your convenience.

Phone: +61 8 9321 1702
Email: training@idc-online.com       
Website: www.idc-online.com

INDUSTRIAL
DATA COMMS

AUTOMATION & 
PROCESS CONTROL

ELECTRONICS

ELECTRICAL 
POWER

MECHANICAL 
ENGINEERING

OIL & GAS
ENGINEERING

For a no obligation proposal, contact us today 
  at training@idc-online.com or visit our website 
    for more information: www.idc-online.com/onsite/  
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Deleting Shapes

Deleting Shapes
•	 Select the shape to be deleted.
•	 Press the Delete key.
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Resizing Shapes

Resizing Shapes
Resizing a Shape with the Mouse

•	 Select the shape to be resized.
•	 Move the mouse pointer to the required Resize handle:

 

•	 Drag the handle until the shape is at the required size.
•	 Release the mouse button.

Click and drag on any corner when resizing to maintain the shape’s height-to-width proportions.

Resizing a Shape with the Size & Position Window

•	 Select the shape to be resized.
•	 From the View Ribbon, Show section, Task Panes select Size & Position.

http://bookboon.com/


Download free ebooks at bookboon.com

Visio 2010

87 

Resizing Shapes

•	 the following window will appear in the bottom left of the screen:

•	 Increase/decrease the Width and Height values to change the size of the shape.
•	 The X and Y values refer to the position of the shape on the drawing page.

Revising Existing Shapes

To revise the geometry of almost any shape, select it with the Pencil tool , and then drag, add, or delete vertices. To 
change curves, drag a control point or a point’s eccentricity handles. 

  TIP You can select multiple vertices and move them as unit to easily preserve their relative position to each 
other.

One way to reshape a shape is to drag a vertex (A) with the Pencil tool.

To add a segment, point to where you want to add the segment, hold down the CTRL key, and click with the Pencil tool 
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Resizing Shapes

(A). Then you can drag the new vertex with the Pencil tool to the position you want.

If you want fewer segments in a shape, delete the segments you don’t want.

To delete a segment, select a vertex with the Pencil tool (A), and then press DELETE. The segment that the vertex is 
associated with is deleted. The remaining segments are reshaped accordingly.

How the Visio engine redraws the shape when you delete a vertex depends on whether the vertex is at the beginning or 
end of an open shape, the order that the segments were created in, and whether the segment that follows the vertex you 
delete is a line or arc. After you delete segments, you might need to adjust the shape by dragging vertices and control 
points until the shape appears the way you want.

To change the curvature of an arc or freeform curve, drag a control point (A) until the segment appears the way you want
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Rotating Shapes

Rotating Shapes
•	 Select the shape.
•	 Use the Rotate handle to drag the shape round as far as necessary:

Changing the Centre of Rotation

The centre of rotation is normally positioned in the centre of the shape and defines the point at which the shape will 
rotate. The centre of rotation can be moved at any time.

•	 Select the shape and move the mouse pointer over the Rotate handle (see above).
•	 The Centre of Rotation will appear in the centre of the shape:

•	 Move the mouse over the centre of rotation and click & drag it to another position.
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Flipping Shapes

Flipping Shapes
•	 Select the shape to be flipped.
•	 Select Flip Horizontal or Flip Vertical from Rotate Shapes menu under the Position button on the Home 

Ribbon:

Maersk.com/Mitas

�e Graduate Programme  
for Engineers and Geoscientists

Month 16
I was a construction

supervisor in  
the North Sea  

advising and  
helping foremen  

solve problems

I was a

he
s

Real work  
International opportunities 

�ree work placements
al Internationa
or�ree wo

I wanted real responsibili� 
 I joined MITAS because  
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Duplicating/Copying Shapes

Duplicating/Copying Shapes
Duplicating a Shape

•	 Select the shape to be duplicated.
•	 Select Duplicate from the Paste Button on the Home Ribbon, and a copy of the shape will appear directly 

beside the original:

•	 CTRL+D will do the same.

OR

•	 Hold down the CTRL key and move the shape to its new position, a copy is created.

Copying a Shape between Pages

•	 Select the shape to be copied.
•	 Select Copy from the Home Ribbon.
•	 Move to the page where the copy is required.
•	 Select Paste from the Edit menu.
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Duplicating/Copying Shapes

Moving a Shape between Pages

•	 Select the shape to be moved.
•	 Select Cut from the Home Ribbon.
•	 Go to the page where the shape is required.
•	 Select Paste from the Edit menu.

www.job.oticon.dk
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Changing the attributes of a Shape
Attributes, such as line and fill colour, can be changed to alter the appearance of a shape.

To Change Line (Border) Attributes

•	 Select the shape for which the line attributes are to be changed.
•	 Select Line from the Shape section on the Home Ribbon – the Line options palette will appear:

OR

•	 Right Click on the shape and select Format, Line.
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•	 The Format Line window will appear:

Line

Dash Type 
Weight 
Colour 

Changes the style of the line, e.g. dotted, dashed etc. Changes the 
thickness of a line or a line around a shape. Changes the colour of the 
line or the line colour of a shape.

Cap Makes the ends of a line either round or square. This may not be visible 
if the line is fairly thin.

Transparency This sets the transparency of the line, from 0 to 100.

Line Ends

Begin/End Changes the style of the beginning/end of the line, e.g. adds arrowhead.

Begin/End Size Changes the size of the beginning/end of line attachments.

Round Corners Gives you the option to smooth the corners of the line or shape.

•	 Choose OK to finish.

To Change Fill Attributes

•	 Select the shape for which the fill attributes are to be changed.
•	 Select Fill from the Shape section on the Home Ribbon – the Line options palette will appear: 
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OR

•	 Right click on the shape, Format, Fill. 

•	 The Fill dialog box will appear:
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Changing the attributes of a Shape

Fill

Colour Allows the colour of the shape to be chosen.

Pattern Allows a pattern to be applied to the fill of the shape.

Pattern Colour Allows the colour of the pattern to be chosen.

Transparency Sets the Transparency of the fill, from 0 to 100.

Shadow Shadow settings can be set from this section.

•	 Choose OK to finish.
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Stacking Shapes
When you are working with shapes, you will find that you sometimes need to stack them to get the effect you want. When 
you stack shapes on top of each other, they will overlap. Visio has commands to move shapes up or down in a stack.

Bringing Shapes to the Front/Back  of a Stack

•	 The Bring to Front and Send to Back commands move a shape to the top or bottom of the stack.
•	 Select the shape you want to move.

From the Home Ribbon, Arrange choose Bring Forward or Send Backward. The following sub-menus will appear:
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Stacking Shapes

•	 Select Bring to Front or Send to Back to move the shape all the way to the front or all the way to the back 
of the stack.

•	 Select Bring Forward or Send Backward to move the shape up or down in the stack one level at the time.
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Aligning shapes
If you have created a number of shapes, you can align the entire group on their left/right borders, their top/bottom border 
or their centres. You do not have to select and move each shape individually.

•	 Select the first shape, the handles will be green. This will be the master shape.
•	 Select the other shapes using the SHFT key (or the Area Select/Lasso option from the Select button).
•	 The blue handles will surround all of the selected shapes. The first shape (the master) will now have a thick 

pink border, while the subsequent shapes selected will have a thinner pink border:

•	 Choose Position from the Arrange section on the Home Ribbon and select alignment option.
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Distributing Shapes
If you have created a number of shapes, you can distribute space equally between them.

•	 Select the shapes you want to distribute space between.
•	 Select the Position Button, Space shapes, and select the required distribution option.

•	 For more options select the Position Button, Space shapes, and More Distribute Options. The Distribute 
Shapes dialog opens:

•	 Select the type of distribution you want.
•	 Click on OK.
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Grouping Shapes
When you have selected two or more shapes, you can create a group. Once you have a group, any attribute you choose 
such as shadow or line colour, is assigned to all the individual shapes within a group – as long as it applies (e.g. you cannot 
have a line with a shaded fill). The grouped shapes all move and rotate as a group.

Two Shapes Selected – NOT Grouped

Two Shapes Grouped

To Group Selected Shapes

•	 Select the shapes to be grouped.
•	 Choose Group button from the Home Ribbon, Arrange section and then Group 
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OR

•	 Press CTRL+G.

To Ungroup Shapes

•	 Select the group by clicking on one of its shapes.
•	 Choose Group button from the Home Ribbon, Arrange section and then Ungroup 

OR

•	 Press CTRL+SHFT+U.
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Grouping Shapes

Selecting a Shape within a Group

•	 Select the group.
•	 Select the shape you want to alter. 

•	 Format the shape.
•	 Or click & drag the shape to move it within the boundaries of the group.
•	 Click away from the shape to deselect the group when you have finished.

it’s an interesting world

Get under the skin of it.
Graduate opportunities
Cheltenham | £24,945 + benefits

One of the UK’s intelligence services, GCHQ’s role is two-fold: 
to gather and analyse intelligence which helps shape Britain’s
response to global events, and, to provide technical advice for the
protection of Government communication and information systems.
In doing so, our specialists – in IT, internet, engineering, languages,
information assurance, mathematics and intelligence – get well
beneath the surface of global affairs. If you thought the world was 
an interesting place, you really ought to explore our world of work.

www.careersinbritishintelligence.co.uk
Applicants must be British citizens. GCHQ values diversity and welcomes applicants from
all sections of the community. We want our workforce to reflect the diversity of our work.

TOP
GOVERNMENT

EMPLOYER

http://bookboon.com/
http://bookboon.com/count/advert/2f9ffd82-96d7-e011-adca-22a08ed629e5


Download free ebooks at bookboon.com

Visio 2010

104 

Adjusting Shape Layout

Adjusting Shape Layout
•	 Select the design tab

Click on the layout group to open the dialogue box Shown below

Experiment changing the option to see the impact that they make 

Click the spacing button to open advanced spacing options.
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Adjusting Shape Layout

Experiment changing the options to see the impact that they make
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Managing Pages
Creating a new page

•	 A new page can be added after the page that is currently displayed.
•	 Select Bank Page from the Insert ribbon.

OR

Click on the Insert Page Tab at the bottom of the window.

Moving Between Pages 

•	 Page Tabs appear at the bottom of the screen:

•	 Click onto a Tab to switch to that page.

OR

•	 Pressing CTRL+ Page Up/Down will move you forward or backward one page at a time through the file.
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Ruler, Grid and Guides

Ruler, Grid and Guides
The page has a visible Grid of squares designed to help with the positioning of shapes. The size of the squares on this grid 
will change as you zoom in and out of the page.

There are also vertical and horizontal Rulers found on the left and top of the drawing page.

Both of these features can be adjusted from the Show section of the View Ribbon.
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In Paris or Online
International programs taught by professors and professionals from all over the world 

BBA in Global Business
MBA in International Management / International Marketing
DBA in International Business / International Management
MA in International Education
MA in Cross-Cultural Communication
MA in Foreign Languages

Innovative – Practical – Flexible – Affordable

Visit: www.HorizonsUniversity.org
Write: Admissions@horizonsuniversity.org
Call: 01.42.77.20.66 www.HorizonsUniversity.org
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Snap & Glue
As one shape is moved close to another on a drawing page, the two will tend to line up exactly without a gap between 
them. This is a feature called Snap. This is typically what you would want to happen to help with the overall appearance 
of your drawing. The feature can be deactivated by choosing extended options to open dialogue box as shown .
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Guides
Guides are another method designed to help with the positioning of shapes. Both horizontal and vertical guides can be 
introduced to the drawing page.

•	 Move the mouse pointer to one of the rulers (the top ruler for a horizontal guide, the left ruler for a 
vertical).

•	 Click & drag onto the drawing page. The guide will be created wherever the mouse is released.
•	 Guides can be moved, copied and deleted just like normal shapes.
•	 Guide Points can be added by dragging them to the page from the Upper left hand corner of the ruler.

•	 Visio also displays the drawing guides while you are adding shapes onto the drawing.
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Use drawing explorer window
The Drawing Explorer window contains icons that represent everything in your diagram. Related items are grouped 
together in folders. For example, there is a folder for all the foreground pages. Inside this folder is a icon for each page, 
identified by the page name. When you select a page icon, that page opens in the diagram area. 

Under each page are subfolders that contain icons for all the shapes and layers on that page. If a shape is composed of a 
group of smaller shapes, all of those smaller shapes are represented in a subfolder under the main shape icon. You can 
select any shape on a diagram page, or any subshape in a group, by selecting it in the Drawing Explorer window.

To view the Drawing Explorer window, you must have the Developer tab visible. By default, this tab is hidden. 

View the Developer tab

•	 Click the File tab. 
•	 Under Visio, click Options. 
•	 Click Advanced, and scroll down to the General section. 
•	 Select Run in developer mode.

Use the Drawing Explorer window

•	 On the Developer tab, in the Show/Hide group, select Drawing Explorer. 
•	 Do one or more of the following: 
•	 To open or close a folder, double-click it. 
•	 To change the name of an item, press F2, type over the highlighted text, and then press ENTER. 
•	 To immediately undo a name change, press ESC.
•	 To select a shape in the diagram window, in the Drawing Explorer window, click the plus sign next to the 

Foreground Pages or Background Pages folder, and then click the shape you want.

http://bookboon.com/


Download free ebooks at bookboon.com

Visio 2010

111 

Set drawing scale

Set drawing scale
What Is the Purpose of Drawing Scale?

Whenever you need to re-create the exact spatial relationships--as well as relate objects to one another--of very small or 
very large objects in the space of a drawing page, you must set a drawing scale. When a drawing is made for real-world 
objects that are larger than paper size, you must draw to scale. For example, 1 inch on the drawing page of an office layout 
might represent 1 foot of the actual office. 

How Do I Set Drawing Scale?

When you start a drawing by opening a solution, the drawing scale and measurement units are already set for you. Some 
solutions, however (such as the Basic Flowchart solution), are unscaled because you use them to create abstract drawings 
that do not represent actual objects in the real world. 

You can set the drawing scale in any drawing. If you want to work with a different drawing scale, you can change the setting.

To set drawing scale 

•	 On the File menu, click Page Setup, and then click the Drawing Scale tab.

  NOTE: In a multiple-page drawing, each page can have a different scale. The rulers in each of these 
drawings reflect their different drawing scales. 
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What Issues Should I know about?

What Issues Should I know about?
When you set a drawing scale, keep the following points in mind: 

•	 Changing a page’s drawing scale does not change any background pages assigned to that page; therefore, 
you must set their drawing scale separately if you want the foreground and background pages to match. This 
feature allows a single file to contain multiple drawing scales. 

•	 Most masters are designed for drawings that have a scale of 1:1. An instance of a master is automatically 
adjusted if its drawing scale is more than eight times larger or smaller than the drawing scale of the page. If 
the scales differ less, the shape is not adjusted. 

•	 If you change the drawing scale, the corresponding real-world size of an object does not change. Visio 
updates the drawing so that the object takes up more or less space on the page, depending on your change
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Drawing Scales Explained
Drawing scales are sometimes expressed as a ratio without measurement units. For example, the metric scale for an office 
layout might be expressed as 1:50, which is the same as 2 cm = 1 m if you measure distances in centimetres and meters.

The smaller the ratio, the larger the area you can represent:

With a scale such as 1:100 (metric units) or 1/8” = 1’ (US units), you can draw an entire floor on one page. 

With a scale such as 1:10 (metric units) or 1” = 1’ (US units), you can focus in on one cubicle.

When you choose a drawing scale, Microsoft Office Visio sets the measurement units and page units automatically.

Measurement units represent sizes or distances in the real world. In an office layout with a drawing scale of 2 cm = 1 m 
(1:50), meters are the measurement unit. In a drawing scale of 1/4” = 1’, feet are the measurement unit.

Page units represent sizes or distances on the printed page. In an office layout with a drawing scale of 2 cm = 1 m (1:50), 
centimetres are the page unit. In a drawing scale of 1/4” = 1’, inches are the page unit.

Shapes are designed to work with the template they come with. Building plan shapes, for example, work best with scaled 
drawings, while flowchart shapes work best with unscaled (1:1) drawings.

When you drag a shape onto a drawing page, the shape resizes to match the drawing scale. If the scale of the shape is 
much larger or much smaller than the scale of the drawing page, the shape is not resized. Consider using another shape 
designed to work with a scaled drawing.
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Choosing an Appropriate Drawing 
Scale
Any drawing that depicts physical objects that are too small or too large to be drawn easily, or are larger than the paper 
size, must be scaled to fit on the page. For example, in an architectural rendering of a house, 1/4 inch on the drawing 
page might represent 1 foot of the actual house. Schematic diagrams, such as flowcharts and organization charts, depict 
abstract objects; therefore, these types of drawings are unscaled.

In Microsoft® Visio®, drawing units are sizes in the real world. In the previous example of a house, 1 foot is the drawing 
unit. Page units are sizes on the printed page—1/4 inch in the house example. The ratio of page units to drawing units 
is the drawing scale. 

ShapeSheet® cells that describe object size or position that is, most cells are expressed in drawing units. Cells that represent 
measurements on the printed page, such as text format and indents, are shown in page units. If the drawing scale is changed, 
all ShapeSheet cells that are expressed in drawing units remain constant, but the shape is redrawn to the new scale. 

Understanding Drawing Scale and Page Scale

To understand how drawing scale and page scale relate to each other, consider the swimming pool in the following figure. 
The pool is 40 feet long and 20 feet wide, drawn using a 1-point line, and labelled using 8-point type. 

With a drawing scale of 1/4 inch = 1 foot (1:48), the picture of the pool is drawn 10 inches long by 5 inches wide. If you 
change the drawing scale to 1/8 inch = 1 foot (1:96), the pool is still 40 feet long and 20 feet wide; however, the picture of 
the pool is now only 5 inches by 21/2 inches. Regardless of the scale, the line size remains 1 point and the font size 8 points.
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The pool is 40 ft by 20 ft in drawing units, regardless of the drawing scale.

a) Drawing scale: 1/4 in. = 1 ft (1:48)
b) In page units, the pool is 10 in. by 5 in. in this drawing scale.
c) Drawing scale: 1/8 in. = 1 ft. (1:96)
d) In page units, the pool is 5 in. by 2-1/2 in. in this drawing scale.

Factors to Consider in Choosing a Drawing Scale

To choose the appropriate drawing scale to include in a template, consider the following:

•	 The expected size of the drawing, in drawing units
•	 The paper size on which users will print their drawings
•	 The industry or drawing conventions that apply to the drawing type users create with your template, such as 

margins or title blocks

For example, a user can print a house plan on an 81/2-inch by 11-inch sheet of paper, in landscape orientation. If the 
drawing scale is 1/4 inch = 1 foot, the drawing page represents 34 feet by 44 feet (assuming no margins are set for the 
printed page). An area of 34 feet by 44 feet might not be large enough to accommodate the house and its landscape design. 
Instead, you might choose a smaller scale, such as 1/8 inch = 1 foot or 1 inch = 10 feet.
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  TIP Drawing units can represent measurements other than distance. You can use elapsed time rather than 
distance for a page scale by setting the drawing units to hours, days, weeks, months, and so on. For example, 
you can use elapsed weeks (abbreviated “ew” in ShapeSheet formulas) as the drawing units for the diagram 
of a project timeline. For a complete list of units, see the Microsoft Visio Developer Reference. 
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Change the drawing scale
Display the page for which you want to change the drawing scale. 

You can set a different drawing scale for each page in your drawing.

1. On the File menu, click Page Setup, and then click the Drawing Scale tab. 
2. Click Pre-defined scale, and then click a pre-defined architectural, metric, or engineering scale; or click 

Custom Scale and type a custom scale. 
3. To change the measurement units (such as feet or meters), click the Page Properties tab, and in the 

Measurement units list, click the units that you want. 
4. Click Apply to save your changes and update the drawing page. 

To give the background pages the same drawing scale, display the background page and follow steps 1–4.

The drawing shows the new settings. Shapes might appear larger or smaller, but their real-world size does not change. 
Rulers show the new measurement units.

Changing Layout and Line jump

Layouts and line jump can be accessed from either of these connectors, or Re-Layout Page Options then select More 
layout options.

http://bookboon.com/


Download free ebooks at bookboon.com

Visio 2010

118 

Change the drawing scale

http://bookboon.com/


Download free ebooks at bookboon.com

Visio 2010

119 

Print Drawings – Print preview

Print Drawings – Print preview 
From the file menu you can access quick print, print and print preview.

Print range Number of copies - Select a printer

Selecting the print option opens the print dialogue box you can also select the printer from here.
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Paper size orientation
Open the advanced option by clicking the expanded options on page set up.

http://bookboon.com/


Download free ebooks at bookboon.com

Visio 2010

121 

Formatting Text

Formatting Text
Change font type

Font Size

Font colour

Font Case
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Formatting Text

Vertical Horizontal text alignment

Change line indent

Change text margins and Text Background shading

Expand paragraph group to access advanced options Text Block TAB
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Bullets

Or select expanded group options Bullets tab

Spell check

•	 On the Review tab, in the Proofing group, click Spelling. 

  You can access this command quickly by adding it to the Quick Access Toolbar by right-clicking the Spelling 
button, and then clicking Add to Quick Access Toolbar on the shortcut menu.

•	 If the program finds spelling mistakes, a dialog box or task pane appears with the first misspelled word 
found by the spelling checker. 

•	 After you resolve each misspelled word, the program flags the next misspelled word so that you can decide 
what you want to do.
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Layers
Effectively using layers in Visio can allow you layout multiple systems on one drawing page and then toggle between 
turning layers on/off depending on who is viewing the drawing. Layers allow you to have just one drawing page for each 
floor plan within your project that contains all systems for the project, e.g. security, lighting, A/V.

Assign a shape to a layer

•	 Select your shape 
•	 From the home tab select Editing
•	 Select Layers, Assign to Layer

Visio sets the default layer for the shape as flowchart; many predefined shapes will be assigned a layer when you place it 
on your drawing. 
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the best master  
in the netherlands
Kickstart your career. Start your MSc in Management in September, graduate within 16 months 
and join 15,000 alumni from more than 80 countries.

Are you ready to take the challenge? Register for our MSc in Management Challenge and compete 
to win 1 of 3 partial-tuition revolving scholarships worth € 10,000!

www.nyenrode.nl/msc

Master of Science in Management

* Keuzegids Higher Education Masters 2012,  
in the category of business administration

*
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Layers

Layer options

•	 From the home page select editing
•	 Layers, Layer Properties
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Layers

On this form you can lock layers as well as choose what layers are visible or not.   You may wish to show a client the 
drawing without the wires showing.   To do this, uncheck the “Visible” box for the Wire and Cable layer.   The drawing 
will now display without the wires.

Add new layer

•	 Select your shape 
•	 From the home tab select Editing
•	 Select Layers, Assign to Layer
•	 Select New

Add layer name

The layer you created has been assigned  
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•	 Un check flowchart to finish the procedure 

Destination MMU
MMU is proud to be one of the most popular universities in the UK. 
Some 34,000 students from all parts of the globe select from its 
curricula of over 1,000 courses and qualifications. 

We are based in the dynamic yet conveniently compact city of Manchester, 
located at the heart of a sophisticated transport network including a major 
international airport on the outskirts. Parts of the campus are acclaimed for 
their architectural style and date back over 150 years, in direct contrast to 
our teaching style which is thoroughly  modern, innovative and 
forward-thinking. 

MMU offers undergraduate and postgraduate courses in 
the following subject areas: 

• Art, Design & Performance 
• Computing, Engineering & Technology 
• Business & Management 
• Science, Environmental Studies & Geography 
• Law, Education & Psychology 
• Food, Hospitality, Tourism & Leisure Studies 
• Humanities & Social Science 

For more details or an application form
please contact MMU International.
email: international@mmu.ac.uk
telephone: +44 (0)161 247 1022
www.mmu.ac.uk/international
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Insert Clipart Insert Pictures

From the insert menu you can select either picture or clipart.

•	 Clicking on picture to open insert picture explorer, navigate to the picture of you 
choice to open.

•	 Clicking on clip art opens the clipart panel
•	 Type on what you want to search for and select media type
•	 Click on go for your results
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Develop the tools we need for Life Science
Masters Degree in Bioinformatics

Bioinformatics is the  
exciting field where biology, 
computer science, and  
mathematics meet.  

We solve problems from 
biology and medicine using 
methods and tools from  
computer science and  
mathematics.

Read more about this and our other international masters degree programmes at www.uu.se/master
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Working with the shape sheet 
window
The main use of the shape sheet window is for programming beyond the scope of this course however below we have 
one tip for the manipulation of text.

Basic Text Resizing Formula

Char.Size is the ShapeSheet cell that holds the font size for the shape. It’s located — aptly — in the Character section of 
the ShapeSheet

=height/3, is the formula used to give text 1/3rd the height of the text box experiment with the following. =HEIGHT/2, 
=HEIGHT/2.5, =HEIGHT/2.25

  The font-size for this shape won’t change with the Width of the shape, only the Height.
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Shape properties
A Microsoft Office Visio drawing is more than a picture it’s also a valuable way to store data. A shape can act as a visual 
database field that stores data you can retrieve in a report. For example, a flowchart shape can store data about the cost, 
duration, and resources involved in the process step the shape represents.

Many Visio shapes have predefined custom properties so you can associate data with or affect the appearance of the shape. 
For example: Many of the flowchart shapes have custom properties in which you can enter cost, duration, and resources 
information.

Some office layout shapes have custom properties in which you can enter information such as inventory number and 
owner. Some shapes have properties that change the appearance of the shape, such as the dimension, type, and offset 
properties of the shapes on the Walls, Doors and Windows stencil.

You can edit custom properties in existing shapes, add new properties, or delete properties you don’t need. You can also 
add custom properties to new shapes you create. For example, you can add a new custom property to furniture shapes to 
store the cost of the item. Where you edit custom properties depends on what you intend to do with the shapes.

To edit custom properties for only a single shape, edit the shape on the drawing page. 

To add a group of the same custom properties to many shapes on a drawing or on a custom stencil, create a custom property 
set. For example, to add Employee Number, Start Date, and Salary properties to the shapes in an organization chart, you 
could create a custom property set with those properties and then add it to all of the shapes in an organization chart.

Setting up Shape Properties

Add TEXT
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Shape Reports
Generating an Excel Bill of Materials from Data Stored in Shapes by Using the 
Reports Tool

From within Visio 2010, you can create reports that present your data in a variety of ways. One example is reporting data 
from Visio 2010 to Office Excel. If you create a drawing and you add data to the shape or to your Shape Data fields, you 
can generate an Excel report summarizing that data. In the graphic below, data has been associated with the equipment 
shapes in the diagram by using Shape Data fields, and it is displayed by using data graphics. 

A network diagram with associated Shape Data

To report on the data contained in the diagram

1. On the Data menu, click Reports.
2. In the Reports dialog box, choose the report to run. You can modify an existing report or you can create 

and save a new report.
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The Reports dialog box enables you to run or modify existing reports or to create a 

report

3. By selecting Modify or New, you can choose the fields on which you want to report.
4. In the Report Definition Wizard, choose which shapes you want to include in your report: Shapes on all 

pages, Shapes on the current page, or selected shapes.
5.  Specify which shapes are in your report
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6. On the next page of the Report Definition Wizard, specify which fields you want to export to your 
Excel 2007 report.

7. On the next page, type a title for your report and indicate how you want the data sorted and formatted.
8. Run the report. Select Excel as the reporting format.

9.  Data reported to Excel from the Visio 2010 network diagram
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Pivot Diagrams: Analyzing Data by Using Different Views

Visio 2010 enables you to easily track trends, identify potential problem areas, and flag exceptions by using Pivot Diagrams.

Pivot Diagrams, new in Visio 2010, give you the power to visualize business data in a variety of ways. Pivot Diagrams 
show data as a collection of shapes arranged in a tree-like structure that helps you to analyze and summarize data in a 
visual, easy-to-understand format. By using Pivot Diagrams, you can visually explore your business data, analyze it, and 
create multiple views of it to gain deeper insight into the information.

You can also apply conditional formatting to track trends, identify potential problem areas, and flag exceptions. Pivot 
Diagrams are a graphical representation of the same kinds of information you might view in a pivot table. For example, 
you might show variable data as progress bars, demonstrate data that increases or decreases with arrows or speedometers, 
and indicate incomplete or problem data by displaying a large red X. You can insert a Pivot Diagram into any other Visio 
diagram to provide a complementary view of the data.

To create a Pivot Diagram, open the Pivot Diagram template; the Data Selector Wizard starts immediately. From another 
drawing type, on the Insert Data menu, you can also select Insert Pivot Diagram. The wizard guides you through each 
step of connecting the diagram to a data source, and then creates what is called a “pivot node,” which is linked to all of 
the data in the data source. You can expand the pivot node to show various levels that correspond to the data that you 
want to analyze.
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You can use Pivot Diagrams to view data in a variety of ways. In the previous illustration, the data is first categorized by 
Administrator and then by IP Address. In illustration, notice that:

•	 The Count Field, Memory field, and CPU field are numeric categories and can be accumulated at each 
level.

•	 You can associate shapes with the pivot nodes to better illustrate each level. In this example, a person shape 
is associated with the node at the Administrator level and a computer shape is associated with each node 
at the IP Address level.

10. You can apply data graphics to make the information in the diagram stand out more distinctly. A data 
graphic has been applied for the amount of memory in each computer. If the computer has at least 1 MB of 
memory, the data graphic shows a green check mark. If the computer has less than 1 MB of memory, the 
data graphic shows a red X.

SSTSTSTSTTUUDUDDYY Y IINN SSWWWEDEN 
––  HHOHOOMMEMEE O OOFF THE NOBEL PRIZE
CLOSE COLLABORATION WITH FUTURE 
EMPLOYERS SUCH AS ABB AND ERICSSON

WWEWWEWEELLCLCCOOMOME E TTOO 
OOOUOUURR WWOORRLLDD
OOFOFF T TEAACCHCHINNG!G!
INNOVATION, FLAT HIERARCHIES 
AND OPEN-MINDED PROFESSORS

SASHA SHAHBAZI 
LEFT IRAN FOR A 

MASTERS IN PRODUCT 
AND PROCESS 

DEVELOPMENT AND 
LOTS OF INNEBANDY
HE’LL TELL YOU ALL ABOUT IT AND 

ANSWER YOUR QUESTIONS AT 
MDUSTUDENT.COM

www.mdh.se
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Pivot Diagram showing inventory of network equipment

Categories, Levels, and Nodes

To understand categories, levels, and nodes, think of each element in the context of your data source:

•	 Notice that each column of your data source is either non-numeric or numeric. 
•	 Think of the non-numeric columns as categories—for example, Manufacturer, Administrator, or IP 

Address. Any of these can become a level under the top node. 

  Note: The values under a column like IP Address might be numbers, but they are not numbers 
that can be totaled or otherwise summarized.

•	 Think of the numeric columns as data, such as numbers or currency, that can be summed or averaged, or 
that have minimum or maximum values.

•	 Think of each node as a group of rows from your data source that have a common value in a specified 
column. For example, for the category Administrator, all the rows with “Don Hall” would be grouped 
into a single node.
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You can use the following data sources to create a Pivot Diagram: 

•	 Microsoft Office Excel workbooks
•	 Microsoft Office Access databases
•	 Microsoft Office SharePoint lists
•	 Microsoft SQL Server databases
•	 Microsoft SQL Server Analysis Services 
•	 Other OLE databases or Open Database Connectivity (ODBC) data sources 

A Pivot Diagram demonstrating recruiting information by Status

Drag a report shape onto the drawing page. 

Space report

The Space report shape creates a tabular report of the spaces in your drawing.

Asset report

The Asset report shape creates a tabular report of the assets in your drawing.
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Move report

The Move report shape creates a tabular report of the rooms people are in.

Door schedule

The Door schedule shape creates a tabular report of the doors in your drawing.

Window schedule

The Window schedule shape creates a tabular report of the windows in your drawing.

1. If items in the drawing change, you can refresh the information in the report. To run the report again, right-
click the report shape, and then click Run Report.
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Shape Protection
To protect a shape

1. Select a shape. 
2. From the Developer Tab, click Protection. 
3. Select the shape attributes that you want to lock, or clear the check boxes for the attributes you want to 

unlock, and then click OK. 

  Note:  As long as an ink shape can be selected for editing (with one of the available pen tools), ink strokes can 
be added to or erased from the ink shape even when various shape attributes are selected in the Protection 
dialog box. To prevent any changes to an ink shape, lock the shape against selection.

To protect a Drawing

1. On the Developer Tab, click Drawing Explorer Window. 
2. Right-click the name of the drawing, and then click Protect Document. 
3. From the Protect dialogue box, select Shapes, and then click OK. 

To unprotect a Drawing

To unlock shapes from selection, follow the previous steps, but clear the Shapes check box, and then click OK.
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Automatic page sizing
When you start a new diagram, you typically begin with a single drawing page that is the size of a standard piece of printer 
paper.  Many diagrams grow beyond the size of a single printed sheet.  Visio 2010 adds a dynamic page sizing capability 
that responds as you draw, so you no longer have to manually adjust your page size to your diagram.

As you draw beyond the edge of the current page, Visio expands the page in that direction by one additional tile, or 
printer paper sheet.
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If you live preview adding a shape with Auto Connect, Visio also previews the tiles that will be added.  As you drag shapes 
outside the current page or drag shapes from the Shapes window, Visio shows a translucent preview of the new tiles that 
will be added if the shape is dropped in its current location.

 

All sorts of things can affect the size of your diagram when printed, including adding shapes, deleting shapes, moving 
shapes, adding or removing text and changing text properties.  Any of these will alert Visio to update the page larger or 
smaller to keep the drawing within full tiles.
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Start with this:

Add more text:

Delete the shape:

You may also notice that the depiction of page breaks and margins is different than in Visio 2007.  We simplified the look 
of page breaks and many people will find them similar to Excel’s.  Margins are now a clear white area around the entire 
page.  also enabled is showing page breaks and margins by default in new drawings, to help make it clear how Visio is 
adjusting your page.
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This auto sizing behavior is controlled using the Auto Size toggle button on the Design tab.  If you click the dialog launcher 
and open the Page Setup dialog, you’ll see we replaced the now-defunct “Same as printer paper size” option with “Let 
Visio expand the page as needed”.  The sharp-eyed Visio expert will notice that the “Size to fit drawing contents” option 
is also gone from the dialog.  Since that item was more of a one-time action than a persistent state of tightly fitting the 
page to the diagram, we moved it to the Page Size dropdown and renamed it “Fit to Drawing”.

Since we’re talking about page sizing, it’s also worth taking a quick look at manual page adjustments.  The Orientation and 
Size dropdown buttons on the Design tab surface the most commonly-used items from the Page Setup dialog.
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   When Auto Size is enabled, these reflect the orientation and size of the printer paper (the tiles in the 
drawing page), because Auto Size controls the size of the page based on the printer paper settings.  Changing 
them changes the orientation and size of the printer paper settings.   If you change these, the number of 
tiles required to contain the diagram may also change, so your drawing page may change size.

Size = Letter (8.5” x 11”) 

Orientation = Landscape
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Size = Letter (8.5” x 11”) 

Orientation = Portrait

Do you want your Dream Job?

More customers get their dream job by using RedStarResume than 
any other resume service.

RedStarResume can help you with your job application and CV. 

Go to: Redstarresume.com

Use code “BOOKBOON” and save up to $15

(enter the discount code in the “Discount Code Box”)
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    When Auto Size is disabled, these reflect the orientation and size of the drawing page, because you are 
controlling it, not Visio.   Changing them sets both the drawing page and the printer paper settings, to 
keep them in sync.

Size = Letter (8.5” x 11”) 

Orientation = Landscape
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Size = Letter (8.5” x 11”) 

Orientation = Portrait
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Essentially, we made Orientation and Size work as expected depending on context – whether Auto Size is on or off.  That 
is, whether you have Visio taking care of the page size or if you are doing it

By 2020, wind could provide one-tenth of our planet’s 
electricity needs. Already today, SKF’s innovative know-
how is crucial to running a large proportion of the 
world’s wind turbines. 

Up to 25 % of the generating costs relate to mainte-
nance. These can be reduced dramatically thanks to our 
systems for on-line condition monitoring and automatic 
lubrication. We help make it more economical to create 
cleaner, cheaper energy out of thin air. 

By sharing our experience, expertise, and creativity, 
industries can boost performance beyond expectations. 

Therefore we need the best employees who can 
meet this challenge!

The Power of Knowledge Engineering

Brain power

Plug into The Power of Knowledge Engineering. 

Visit us at www.skf.com/knowledge
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Diagram Validation
Are all the shapes in my diagram labeled? Do I have any loose connectors that are not attached to other shapes? We have 
heard from customers that it is often hard to answer these types of questions, especially in large diagrams. As a result, 
they spend a lot of time manually checking diagrams for errors. At the same time, they have to manually ensure that the 
different diagrams they create are visually consistent.

Many companies also want to enforce certain diagramming standards or rules within their organization. It’s much easier 
for different people to understand a diagram if it uses standardized notation. As an example, many companies are adopting 
BPMN as a standard for business process modeling.

To address these needs, support for diagram validation in Visio 2010, Allows users to check their diagrams for common 
errors and allows companies to ensure that employees are following certain diagramming standards.

 With Visio 2010, included is diagram validation support for Basic Flowchart, Cross Functional Flowchart, and Microsoft 
SharePoint Workflow and Business Process Modeling Notation diagrams. Companies can also develop custom rules for 
their own needs.

•	 You can access the diagram validation functionality from the Process tab. Once you start working on a 
diagram with a supported set of rules, you can click the Check Diagram button to see whether the diagram 
has any issues.

Visio will either tell you that there are no issues in the document, or it will list the issues in the Issues Window. In the 
diagram below, a connector is not attached to the next shape in the flowchart. When the Check Diagram button is clicked, 
Visio displays two issues to fix. To easily find shapes with issues, you can click on an issue and the corresponding shape 
will be selected.
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Once you fix the listed issues, you can click Check Diagram to check that there are no longer any issues with the diagram, 
Sometimes you might find that an issue does not apply to a certain shape in your diagram. When this happens, you can 
ignore the issue and Visio will not display it in the Issues Window. 

If a rule does not apply to the entire diagram, you can also ignore the rule so that no issues associated with that rule are 
displayed. You do this by right-clicking an issue in the Issues Window, and selecting the appropriate option. 

Using the same menu, you can also choose to display the ignored issues and to rearrange issues in the Issues Window 
so that issues with the same rule, category or page are next to each other.

Validation rules are grouped into logical sets of rules, such as BPMN and flowchart rule sets. When you create a new 
Basic Flowchart, Cross Functional Flowchart, Microsoft SharePoint Workflow or Business Process Modelling Notation 
diagram in Visio 2010, the appropriate rule set is automatically available in your document.

 It is also easy to import the flowchart rule set into flowchart diagrams made with previous versions of Visio. Simply 
open your legacy diagram in Visio 2010 and, on the Process tab, click the Check Diagram pull-down menu and then 
click Import Rules From.
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The flowchart rule set is always available to import into a diagram. You can also import rules from other Visio diagrams. 
Any open diagrams with rules sets will be listed as possible sources to import rules from. This makes it easy to add new 
validation rule sets to any diagram.

NNE and Pharmaplan have joined forces to create 
NNE Pharmaplan, the world’s leading engineering 
and consultancy company focused entirely on the 
pharma and biotech industries.

Inés Aréizaga Esteva (Spain), 25 years old
Education: Chemical Engineer

NNE Pharmaplan is the world’s leading engineering and consultancy company 
focused entirely on the pharma and biotech industries. We employ more than 
1500 people worldwide and offer global reach and local knowledge along with 
our all-encompassing list of services.                                    nnepharmaplan.com

– You have to be proactive and open-minded as a 
newcomer and make it clear to your colleagues what 
you are able to cope. The pharmaceutical fi eld is new 
to me. But busy as they are, most of my colleagues 
fi nd the time to teach me, and they also trust me. 
Even though it was a bit hard at fi rst, I can feel over 
time that I am beginning to be taken seriously and 
that my contribution is appreciated.

Trust and responsibility  
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Sub process
The following assumes you already have a process map to work with.

A somewhat cluttered process map.

1. Select the process you wish to include as a sub-process

2. Click on the Process tab in the Office Ribbon.
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3. Click on Create from Selection in the Subprocess group.

You will notice that the process steps you selected will be come one Subprocess shape. You will also notice that new sheet 
was added to the Visio file.

4. To open the Subprocess, hold down the Control [Ctrl] key on your keyboard while clicking on the process.

The newly created page will open containing the process steps you included as a Subprocess.
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5. To return to the main process page, simply click on the appropriate page tab at the bottom of the screen.

The entire process map and the Subprocess should appear.
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Link to external Data
Scenario

Having worked on a state charts for a system re-development and I had a list of existing states from the old application 
that I wanted to cross reference against the new states I had modeled.

Rather than eyeballing everything manually I decided to use the excel .xls with my list of status as a data source in Visio 
and see what was missing from my updated model.

•	 First select the ‘Link Data to Shapes’ option from the Visio ribbon.
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Then as your data source, select an ‘Excel Worksheet’ – remember you could use any of the listed data sources to achieve 
the same objective if that’s easier. It might be a DB extract from a legacy system or a screen dump converted into a table 
or. Excel.xls 

•	 Then choose the .xls (or .xlsx!) you wish to use as your data source.

Now we have to select the range in the excel worksheet to use for our data. If you know the range go ahead and type it 
in, otherwise select ‘Select range’ and manually select the area you wish to use.
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Once it’s in we need to select the column(s) we are concerned with. it may be useful to include an identifier column in 
your data in case you have integrity issues when changing things later on.
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The next screen allows you to assign an identifier column (explained above). This is optional and useful if you plan on 
updating naming conventions and have a larger set of data. Select ok then ‘Finish’ to close the wizard.
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If the import was successful you will see the ‘External data’ window appear with the columns you selected.

From here you can manually ‘drag and drop’ data onto shapes on your diagram to link, but I suggest using the handy 
auto-link feature handily provided by Visio 2010.

Assuming you named your shapes in a similar convention to the imported data, in my case it was naming system states 
and importing old state data, you will get a quick easy link between your source data and your shape elements. If this 
means tidying up your model and/or source data quickly first then it will probably save you time in the long run.
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Data graphics
In Visio 2010, the data graphics feature has had a makeover to integrate it into the ribbon and to address feedback from 
users. also added is a legend feature.

As in Visio 2007, before you can display data using a data graphic, you first need to have some data in your shapes. You 
can add the data manually in the Shape Data Window for each shape, or you can import the data into the diagram from 
an external data source like an Excel worksheet or a SQL database, using the Link Data to Shapes button on the Data tab. 
The data will appear in the External Data Window.

Once you drag a row of data from the External Data Window onto a shape to establish the link to the shape, a set of data 
graphics is created in the Data Graphics gallery, which replaces the task pane used in Visio 2007. The first data graphic 
in the gallery is automatically applied to the data-linked shape.
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You can also create a new data graphic or edit one of the data graphics that Visio built for you in the gallery.

In addition to integrating the user interface into the ribbon, some, improvements to the dialog boxes based on user feedback.

First, if you want to change the way a data field is displayed in the data graphic, you no longer have to delete the data 
field item and add a new one. For example, if you want to make an item display as an icon instead of a text callout, you 
can simply edit the item…

…and switch its display type from Text…
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…to Icon Set.

When you edit a data graphic, you now have a choice between applying the changes to all shapes with that data graphic 
applied (the only option in Visio 2007) or only to the selected shapes, using radio buttons at the bottom of the Edit Data 
Graphic dialog box. The latter choice makes a copy of the data graphic and applies it to the selected shapes.
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You now have more control over the formatting of text and other elements in data graphics. In Visio 2010, you can choose 
the font size used for the value and label in a text callout or data bar, and you can specify the width of the callout.
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Using themes
The built-in themes apply both color formatting (font color, fill color) and shape effects (border style, shadow) to shapes. 
You can choose to change only the effects (border, shadow, font, and connector styles) or only the colors (text, line, 
connector, fill, and shadow colors) of the shapes in your drawing.
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Quick Tasks
Task Action

Apply a theme to the shapes 
in your drawing

On the Design tab, in the Theme group, click the theme that you want 

or click for more options.
Change the theme colors On the Design tab, in the Theme group, click Colors, and select the color 

that you want.
Change the theme effects On the Design tab, in the Theme group, click Effects, and select the 

effects that you want.
Create your own theme On the Design tab, in the Themes group, click Colors and select Create 

New Theme Colors. 

In the New Theme Colors dialog box, under General, in the Name box, 
type a new name that you want to use for your new theme. 

Select the colors that you want. 

Click Apply and then click OK. 

In the Themes group, click Effects and select Create New Theme Effects. 

On the General tab, in the Name box, type a new name that you want to 
use for your new theme. 

Select the font, line, fill, shadow, and connector settings that you want. 

Click Apply and then click OK.
Remove a theme from a shape On the Design tab, in the Theme group, click No Theme.
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Working with containers and Lists
Containers

Containers are collections of shapes surrounded by a visible border.

Add containers

•	 Select the shapes you want to contain. 
•	 On the Insert tab, in the Diagram Parts group, click Container. 
•	 Hold the pointer over the container styles to see a preview of the container on the page. 
•	 Click to insert the container. 
•	 With the container selected, type the heading for the collection of shapes.

   If no shapes are selected when you insert a container, the container is added at the middle of the current 
view. It does not actually contain any shapes, even if it looks like shapes are inside it. Those shapes are 
just in the same place, but the container doesn’t contain them.

Behavior of contained shapes

Contained shapes have a specific relationship with the container, and are affected by actions that are performed on the 
container:

Moving a container moves the contained shapes with it. 

Copying a container copies the contained shapes also. 

Deleting a container deletes the contained shapes.

http://bookboon.com/


Download free ebooks at bookboon.com

P
le

as
e 

cl
ic

k 
th

e 
ad

ve
rt

Visio 2010

170 

Add shapes to a container

Add shapes to a container
You add shapes to a container by dropping them inside the container. You can tell a shape is contained by selecting it – 
the container glows with a slight yellow/orange highlight while contained shapes are selected.

If the container is not highlighted when a shape inside it is selected, move the shape a little inside the container; this has 
the same effect as dropping the shape on. You can also right-click the shape, point to Container, and then click Add to 
Underlying Container.

You can also attach shapes to the edges of containers. When you hold a shape over the edge, the yellow/orange highlight 
appears on just that edge. After you drop the shape, it stays on the edge while you move or resize the container.

Dedicated Analytical Solutions
FOSS
Slangerupgade 69
3400 Hillerød
Tel. +45 70103370

www.foss.dk

The Family owned FOSS group is 

the world leader as supplier of 

dedicated, high-tech analytical 

solutions which measure and 

control the quality and produc-

tion of agricultural, food, phar-

maceutical and chemical produ-

cts. Main activities are initiated 

from Denmark, Sweden and USA 

with headquarters domiciled in 

Hillerød, DK. The products are 

marketed globally by 23 sales 

companies and an extensive net 

of distributors. In line with 

the corevalue to be ‘First’, the 

company intends to expand 

its market position.

Employees at FOSS Analytical A/S are living proof of the company value - First - using 
new inventions to make dedicated solutions for our customers. With sharp minds and 
cross functional teamwork, we constantly strive to develop new unique products - 
Would you like to join our team?

FOSS works diligently with innovation and development as basis for its growth. It is 
reflected in the fact that more than 200 of the 1200 employees in FOSS work with Re-
search & Development in Scandinavia and USA. Engineers at FOSS work in production, 
development and marketing, within a wide range of different fields, i.e. Chemistry, 
Electronics, Mechanics, Software, Optics, Microbiology, Chemometrics.

Sharp Minds - Bright Ideas!

We offer
A challenging job in an international and innovative company that is leading in its field. You will get the 
opportunity to work with the most advanced technology together with highly skilled colleagues. 

Read more about FOSS at www.foss.dk - or go directly to our student site www.foss.dk/sharpminds where 
you can learn more about your possibilities of working together with us on projects, your thesis etc.
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Format a container
While the container is selected, a Container Tools tab named Format is available on the Ribbon. This tab contains commands 
to customize the look and behaviour of the container. 

Set margins and automatic resizing. 

Enhance the style. 

Specify membership commands.

 Lock Container   makes it so shapes cannot be added to the selected container or deleted from it. However, shapes can still 
be moved around inside the container. Also, shapes can be dropped onto the container, but they do not become contained. 

Select Contents   simply selects all the contained shapes.

 Disband Container   deletes the selected container but leaves the shapes that it contained. (If you select a container and 
press DELETE, the contained shapes are deleted too.)

In addition, you can use the formatting commands on the Home tab. For example, you can control the position of the 
container heading text by using the paragraph alignment commands.

Lists

Lists are special kinds of containers – any item you add to a list is automatically arranged in a sequence.

Unlike containers, there are no general-purpose lists that you can add to a diagram. Instead, some shapes have list behavior 
for special uses. Examples include swim lane shapes in cross-functional flowcharts, legend shapes for data graphics, and 
control shapes such as list box in the wireframe template.

You can reorder items in lists by dragging them to new positions, and add items by clicking the list insertion arrow.
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1d shapes 2d shapes
How 1-D and 2-D Shapes Differ

When the size or length of a line shape is less important than the connection it represents, create a 1-D shape. Because 
1-D shapes are often used to connect other shapes, they are often called connectors. For example, in a flowchart, circuit 
diagram, or mechanical illustration, 1-D shapes can be used to connect other components. However, not all 1-D shapes 
are connectors. Some behave as lines, such as callouts or dimension lines, or are simply easier to work with as 1-D shapes, 
such as the wedge of a pie chart.

Most shapes when you first draw them are 2-D. Their width-height boxes have eight handles for resizing. When you draw 
a single arc or line, however, the result is a 1-D shape that has handles for begin and end points and for height adjustment. 
Not only do 1-D and 2-D shapes look different, they behave differently on the drawing page.

Selection handles on 1-D and 2-D shapes

a) 1-D shape
b) Begin point
c) End point
d) 2-D shape converted to 1-D
e) 2-D shape

When a user drags a 2-D shape onto the drawing page, the outline of its alignment box appears rectangular. When a user 
drags a 1-D shape onto the drawing page, its alignment box appears as a straight line. This can make the 1-D shape easier 
for users to align, as with a 1-D wall shape in a space plan.

Two of the 1-D shape’s handles have a special purpose. The starting vertex of a 1-D shape is it’s begin point, and the handle 
that represents the end of the line formed by the shape is the end point.

You can glue the begin or end point of a 1-D shape to a guide, guide point, connection point, shape vertex, or selection 
handle. If you glue one end, the other end stays anchored on the page, and the 1-D shape stretches as the glued end moves 
with the shape to which it is glued.
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Converting 1-D and 2-D Shapes
A shape that looks like a box can behave like a line, because you can convert a 2-D shape to 1-D and vice versa. Converting 
a shape in this way dramatically changes the sections it displays in the ShapeSheet window.

A key difference between a 1-D and 2-D shape is that a 1-D shape includes the 1-D Endpoints section in its ShapeSheet 
window; a 2-D shape does not have this section. Converting a 2-D shape to 1-D adds this section and its default formulas. 
Converting a 1-D shape to 2-D removes this section, regardless of any protection (including GUARD functions) you 
might have set.

When you convert a 2-D shape to a 1-D shape, the Alignment section is deleted, and the formulas in the Shape Transform 
section’s Width, Angle, PinX, and PinY cells are replaced with default 1-D formulas. Converting a shape does not remove 
its connection points, but its connections to other shapes or guides are broken.
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To convert a shape between  
1-D and 2-D 

1. Select the shape.
2. On the Developer Tab, click Behavior.
3. Under Interaction style, select Line (1-dimensional) to specify a 1-D shape. Select Box (2-dimensional) to 

specify a 2-D shape.
4. Click OK.

Visio	modifies	the	shape	and	adjusts	the	alignment	box	according	to	the	behavior	you	chose.

Note One way to create a 1-D shape is to draw the shape as a 2-D shape, convert it to 1-D, and then adjusts the vertices 
and defines custom formulas. You can save time and effort when you initially draw the shape by orienting it horizontally—
that is, by dragging left to right or right to left in the direction you want the line to go. Visio places 1-D endpoints on 
the left and right sides of the shape you draw, so a horizontally drawn shape will be closer to what you want after it is 
converted to 1-D.

Examples of 1-D Shapes

1-D shapes can vary greatly in their appearance and functionality. A 1-D shape might look like a line, or might appear 
to be a 2-D shape. However, as a 1-D shape, you can take advantage of its endpoints. By adding custom formulas, you 
can make the shape behave intelligently when the user drops it on the page, such as a window snapping into place on a 
wall in an office layout.

However, not all 1-D shapes require special formulas to be useful. Because a 1-D shape looks like a line as it is being 
dragged, it can be faster to position in a drawing. Consider using 1-D shapes whenever you want to create masters that 
your users will align precisely in a drawing. For example, a text callout or annotation shape is easier to position accurately 
if users can see exactly where the line will point.

The 1-D shapes shown in the following illustrations have custom formulas that create smart behavior.
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Examples of 1-D shapes

a) Vertical dimension line
b) S-connector
c) Arrow
d) Drip line
e) Diaphragm valve
f) Wall
g) Pie wedge
h) Bus

The formulas for the S-connector keep the connector right-side up. As its endpoints are moved, the shape resizes in a way 
that keeps it upright by stretching its horizontal or vertical segments.

The formulas for the diaphragm valve shape give it height-based resizing behavior. As a user moves an endpoint the line 
stretches, but the middle details remain the same size. If a user increases the shape’s height, the middle details resize 
proportionately, but the line does not change.

The arrow shape shown in the illustration could also be a 2-D shape. Whether such a shape should act like a line or a 
box depends on how it will be used: 

If you intend the arrow to be used in an up-down, left-right manner only, then making it a 2-D shape can make horizontal 
and vertical positioning easier. In addition, 2-D shapes must be rotated using the Rotation tool, whereas it is very easy 
to accidentally change the angle of a 1-D shape by nudging one of its endpoints. However, to allow the arrow shape to 
connect other shapes through the Visio user interface (rather than programmatically), it must either be a 1-D shape or 
have an outward connection point. For details about outward connection 
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Basic Drawings Exercise Examples
In this section you will be presented with a series of step by step examples to re-enforce your Visio Skills.

Process Chart
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Cross functional Charts

Org Charts
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Time Line
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BPMN

   Technical training on 
WHAT you need, WHEN you need it

 At IDC Technologies we can tailor our technical and engineering 
training workshops to suit your needs. We have extensive 

experience in training technical and engineering staff and 
have trained people in organisations such as General 
Motors, Shell, Siemens, BHP and Honeywell to name a few.
Our onsite training is cost effective, convenient and completely 
customisable to the technical and engineering areas you want 
covered. Our workshops are all comprehensive hands-on learning 
experiences with ample time given to practical sessions and 
demonstrations. We communicate well to ensure that workshop content 
and timing match the knowledge, skills, and abilities of the participants.

We run onsite training all year round and hold the workshops on 
your premises or a venue of your choice for your convenience.

Phone: +61 8 9321 1702
Email: training@idc-online.com       
Website: www.idc-online.com

INDUSTRIAL
DATA COMMS

AUTOMATION & 
PROCESS CONTROL

ELECTRONICS

ELECTRICAL 
POWER

MECHANICAL 
ENGINEERING

OIL & GAS
ENGINEERING

For a no obligation proposal, contact us today 
  at training@idc-online.com or visit our website 
    for more information: www.idc-online.com/onsite/  
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BPMN support in Visio 2010

Visio Team 

3 Dec 2009 1:23 PM 

•	 Comments 15 

Business Process Modeling Notation (BPMN) is a standard maintained by the Object Management Group which gives 
businesses the ability to understand their business processes using a graphical notation and to communicate these processes 
in a uniform manner. The basic BPMN shapes are similar to traditional flowcharting shapes, which makes modeling in 
BPMN easy for new users. For advanced users, the BPMN standard contains a large number of detailed shapes—more 
specialized versions of the basic shapes—which are useful when modeling complex interactions or precise behaviors 
within a process.

Companies have told us that they would like to enforce a standardized notation, like BPMN, within their organization 
to ensure that processes are graphically expressed in a consistent manner. Based on this feedback, we introduced the 
following support for BPMN in Visio 2010. 

•	 We support all shapes defined in the BPMN 1.2 standard. 
•	 Our BPMN shapes have associated element attributes, as specified by the standard. 
•	 Using Diagram Validation, a user can check the visual correctness of a diagram against logical rules specified 

in the standard. 

You can find the BPMN Diagram template under the Flowchart category on the New tab of the Backstage View.
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The BPMN Diagram template contains five stencils of BPMN shapes: the BPMN Basic Shapes, BPMN Events, BPMN 
Activities, BPMN Gateways and BPMN Connecting Objects stencils.
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For new BPMN users, all the basic BPMN shapes are located on the BPMN Basic Shapes stencil. For more advanced 
users, additional BPMN shapes can be derived from the basic shapes or taken from the other BPMN stencils.

You can derive a more specialized shape from a basic shape by right-clicking on the shape. The menu below shows how 
you would change a Task to a Standard Loop Task or a Multi-Instance Loop Task. Each of these shapes have different 
graphical symbols to distinguish them and different BPMN properties, or attributes, associated with them.

Notice the BPMN Attributes… option located at the bottom of the above menu. This option launches the Shape Data 
window which displays the shape’s BPMN attributes, properties specified by the BPMN standard. This gives advanced 
BPMN users to option to edit the complete set of BPMN attributes associated with a shape. 
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The BPMN Diagram template and shapes take advantage of many of the new Visio 2010 features. You will notice that the 
ease of use and flowcharting improvements in Visio 2010 make it easy to build visually-appealing BPMN diagrams. Below, 
we focus on some of the other Visio 2010 features that you will encounter when using the BPMN template and shapes.

Diagram Validation

The BPMN standard contains a large number of rules about the visual, structural and semantic properties of a diagram: 
these rules must be satisfied in order to comply with the standard. The standard documentation is long and it is hard for 
new users to understand its intricacies. We use Diagram Validation to help users ensure that their BPMN diagrams are 
visually conformant with the standard. 

The BPMN Diagram template includes validation rules based on the BPMN 1.2 standard. This means that you can use 
the Check Diagram button on the Process tab to check for visual issues with your BPMN diagram. After you validate 
your diagram, any issues are listed in an Issues window.

To easily find shapes with issues, you can click on an issue and the corresponding shape will be selected. Once you fix 
the issues, you can check the diagram again to confirm that there are no longer any problems. This makes it much easier 
to create a BPMN-compliant diagram.

Containers

Expanded Sub-Process and Group shapes in the BPMN template are Containers. This means you can take advantage 
of all the built-in container logic. For example, when you move an Expanded Sub-Process, all the member shapes move 
automatically. In addition, when you select an Expanded Sub-Process or Group, you see the containers contextual tab, 
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which gives you the ability to further customize these shapes. 
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Callouts

The Text Annotation shape in the BPMN template is a Callout. A callout points at or references another shape, which 
we call the “target” of the callout. When a target shape is moved, copied or deleted, any callouts attached to the shape 
will be moved, copied or deleted too.  Thus callouts stay with their target shapes, though you can reposition the callout 
to any offset from its target. 

Cross-functional Flowcharts

The Pool /Lane shape in the BPMN template allows you to add a Pool or Lane shape to your diagram. This shape is based 
on our Cross-functional Flowchart (CFF) shape, which means that Pools and Lanes are easy to manipulate using CFF 
functionality. For example, to add more lanes, you can mouse along the edge of the cross-functional flowchart to where 
you want to add the lane and a blue arrow will appear. Click on the blue arrow and voila, you have a new lane!

The BPMN template combines a large number of new Visio 2010 features to make building BPMN-compliant diagrams 
easier. Both new and advanced BPMN users will benefit from the depth of functionality available while using this template.
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We are interested in your feedback on the new BPMN functionality. You can use the Send a Smile feedback tool or 
comment on the blog to let us know what you think.

Floor Plan

Common used Symbol Definitions 

Symbol
Symbol Name 
(alias)

Symbol Description

Process / Operation Symbols

Process
Show a Process or action step. This is the most 
common symbol in both process flowcharts and 
business process maps.
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Predefined 
Process 
(Subroutine)

A Predefined Process symbol is a marker for 
another process step or series of process flow 
steps that are formally defined elsewhere. This 
shape commonly depicts sub-processes (or 
subroutines in programming flowcharts). If 
the sub-process is considered “known” but not 
actually defined in a process procedure, work 
instruction, or some other process flowchart 
or documentation, then it is best not to use 
this symbol since it implies a formally defined 
process.

Alternate Process

As the shape name suggests, this flowchart 
symbol is used when the process flow step is an 
alternate to the normal process step. Flow lines 
into an alternate process flow step are typically 
dashed.

Delay
The Delay flowchart symbol depicts any waiting 
period that is part of a process. Delay shapes are 
common in process mapping.

Preparation
As the names states, any process step that is a 
Preparation process flow step, such as a set-up 
operation.

Manual 
Operation

Manual Operations flowchart shapes show 
which process steps are not automated. In 
data processing flowcharts, this data flow 
shape indicates a looping operation along with 
a loop limit symbol (which is not supported 
by Microsoft Office, but a Manual Operation 
symbol rotated 180° will do the trick.)

Branching and Control of Flow Symbols

Flow Line  
(Arrow, 
Connector)

Flow line connectors show the direction that the 
process flows.

Terminator 
(Terminal Point, 
Oval)

Terminators show the start and stop points 
in a process. When used as a Start symbol, 
terminators depict a trigger action that sets the 
process flow into motion.

Decision

Indicates a question or branch in the process 
flow. Typically, a Decision   flowchart shape is 
used when there are 2 options (Yes/No, No/
No-Go, etc.)
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Connector 
(Inspection)

Flowchart: In flowcharts, this symbol is typically 
small and is used as a Connector to show a jump 
from one point in the process flow to another. 
Connectors are usually labeled with capital 
letters (A, B, AA) to show matching jump points. 
They are handy for avoiding flow lines that cross 
other shapes and flow lines. They are also handy 
for jumping to and from a sub-processes defined 
in a separate area than the main flowchart. 
Process Mapping: In process maps, 
this symbol is full sized and shows an 
Inspection point in the process flow. 
 
[Just to confuse things further, some people will 
use a circle to indicate an operation and a square 
to indicate an inspection. That’s why it’s important 
to include a symbol key in the flowchart.]

Off-Page 
Connector

Off-Page Connector shows continuation of a 
process flowchart onto another page. When 
using them in conjunction with Connectors, it’s 
best to differentiate the labels, e.g. use numbers 
for Off-Page Connectors and capital letters for 
Connectors. In actual practice, most flowcharts 
just use the Connect shape for both on-page and 
off-page references.

Merge 
(Storage)

Flowchart: Shows the merging of multiple 
processes or information into one. 
Process Mapping: commonly indicates storage 
of raw materials.

Extract 
(Measurement)

Flowchart: Shows when a process splits into 
parallel paths. Also commonly indicates a 
Measurement, with a capital ‘M’ inside the symbol. 
Process Mapping: commonly indicates storage 
of finished goods.

Or

The logical Or symbol shows when a process 
diverges - usually for more than 2 branches. 
When using this symbol, it is important to label 
the out-going flow lines to indicate the criteria 
to follow each branch.
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Summing 
Junction

The logical Summing Junction flowchart shape 
is shows when multiple branches converge into 
a single process. The merge symbol is more 
common for this use, though. This symbol 
and the Or symbol are really more relevant in 
data processing flow diagrams than in process 
flowcharts.

Input and Output Symbols

Data 
(I/O)

The Data flowchart shape indicates inputs to 
and outputs from a process. As such, the shape 
is more often referred to as an I/O shape than 
a Data shape.

Document
Pretty self explanatory - the Document flowchart 
symbol is for a process step that produces a 
document.

Multi-Document

Same as Document, except, well, multiple 
documents. This shape is not as commonly used 
as the Document flowchart shape, even when 
multiple documents are implied.

Display
Indicates a process step where information is 
displayed to a person (e.g., PC user, machine 
operator).

Manual Input

Manual Input flowchart shapes show process 
steps where the operator/ user is prompted for 
information that must be manually input into 
a system.

Card
This is the companion to the punched tape 
flowchart shapes. This shape is seldom used.

Punched Tape

If you’re very good at stretching all the life out of a 
machine, you may still have use for the Punched 
Tape symbol - used for input into old computers 
and CNC machines.

File and Information Storage Symbols

Stored Data

A general Data Storage flowchart shape used for 
any process step that stores data (as opposed to 
the more specific shapes to follow next in this 
table).

Magnetic Disk 
(Database)

The most universally recognizable symbol for 
a data storage location, this flowchart shape 
depicts a database.
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Direct Access 
Storage

Direct Access Storage is a fancy way of saying 
Hard Drive.

Internal Storage
Used in programming flowcharts to mean 
information stored in memory, as opposed to 
on a file.

Sequential Access 
Storage 
(Magnetic Tape)

Although it looks like a ‘Q’, the symbol is 
supposed to look like a reel of tape.

Data Processing Symbols

Collate

The Collate flowchart shape indicates a process 
step that requires organizing data, information, 
or materials according into a standard format 
or arrangement.

Sort
Indicates the sorting of data, information, 
materials into some pre-defined order

www.job.oticon.dk
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Appendix
Changes in Microsoft Visio 2010 - What’s new

This section highlights new features in Visio 2010. 

The Visio 2010 user interface is redesigned and now uses the Microsoft Office Fluent user interface (UI). First introduced 
in the 2007 Microsoft Office system. 

Changes in Microsoft Visio 2010 - The ribbon

The ribbon, part of the Fluent UI, was designed to optimize key Visio design scenarios to make them easier to use. The 
ribbon provides quicker access to all the commands in Visio 2010 and allows for easier future additions and customizations. 
You can also customize the ribbon. For example, you can create custom tabs and custom groups to contain frequently 
used commands. To help maximize the editing of your presentation space on the page, the ribbon can also be hidden 
while you write 

Changes in Microsoft Visio 2010 - Backstage view

The Microsoft Office Backstage is part of the Fluent UI and a companion feature to the ribbon. The Backstage view, which 
can be accessed from the File tab, helps you find frequently used features for managing your Visio drawings. (The File tab 
replaces the Microsoft Office Button and File menu that were used in earlier release of Microsoft Office.) The Backstage 
view is used to manage files and the data about the files, such as creating and saving files, inspecting for hidden metadata 
or personal information, and setting file options. 

Changes in Microsoft Visio 2010 - ShapeSheet IntelliSense

If you are new to ShapeSheet formulas in Visio, they are similar to the formulas in Excel, except you can use them to 
program and recalculate shapes. A ShapeSheet spreadsheet stores information for every Visio shape. Within a ShapeSheet, 
formulas from previous versions of Visio are still valid. 

The IntelliSense is new to Visio 2010. This feature does an automatic lookup and auto-complete for formulas. Some of 
the benefits that ShapeSheet IntelliSense are as follows:

Keyword lookup Keyword auto-complete 

Keyword definition pop-up Function signature hints pop-up 

Parenthesis matching Multi-line formula input for developers 

Supports local and cross-sheet references Changes in Microsoft Visio 2010 - What’s 
changed
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Changes in Microsoft Visio 2010 - Status bar

The following status items are removed from the status bar in Visio 2010, but still appear in the Size & Position window: 

X Y 

Begin X Begin Y 

End X End Y 

Changes in Microsoft Visio 2010 - Customize ink pens

The Customize Pens dialog box is removed in Visio 2010 and replaced with the new Pens model that is used by OfficeArt 
and OneNote. Visio 2010 no longer persists settings for five distinct pens in the registry. Users can no longer see an entry 
point for the Customize Pens dialog box or access the dialog box by any means. Instead, users can customize ink pen 
properties by using the controls on the Ink Tools tab. 

Changes in Microsoft Visio 2010 - Colour by Value

The Colour By Value add-on no longer functions in Visio 2010. It is replaced by the Data Graphics feature set, which 
provides more functionality.. Shapes no longer contain right-click actions to open the add-on. 

Changes in Microsoft Visio 2010 - What’s removed

This section provides information about removed features in Visio 2010. 

Changes in Microsoft Visio 2010 - ShapeStudio

The ShapeStudio tool available in previous versions of the Visio SDK has been removed from the Visio 2010 SDK. 

Changes in Microsoft Visio 2010 - Status bar 

The following status items are removed from the status bar in Visio 2010:

Begin End 

Dx Dy 

Snap Top 

Bottom Left 

Right Tile 

Tile Row Tile Column 

Ancestor 
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